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GigaDevice

3. ITEFXR

3.1. REXFERE

AliELE SES SEELN & S FFEMTEL B 4 wdE (FLBa Tl htps:/gd32mcu.com B F3E
B, % B3-1. #EZHALIELT. 1)1 SES #f, i#id “Package Manager...” A #H4T
TR de, 5% [ 3-2. i & X AL S i “Manually Install Packages...” 1% 25 4%
Wil T e, 5% F3-3. & AL

B 3-1. &SRB R RIE

© Hello - SEGGER Embedded Studio for RISC-V V7.32a (64-bit) - Non-Commercial License - o x
Fie Edt View Serch MNavigste Project Buld Debug Target | Tools  Window  Help
a3 x| e 0 omee CIEIE
1 Debug Toa® o e License Manager.
Broject e Code | Data-RO Package Mansger...
1 Solution Hello Show Instlled Packages
4 D1 Project Hella! Manualy install Packages...

up 1t it

4 Q5o e, modtied o G Mew Ctrek, F
=] New Binary File Comparison
e

e : Studio

Terminal Emulator
Adenin vl

SEGGER Embedded Studio for
RISC-V is up to date

Check for Updates
«©

Projects = B3 open existing ‘ D) create new

Today
O Helo
All packages are up to date Check for Packags
x
Y Y [Tk - £
ée‘ussé‘zmmueu Studio is ready to use
~ Completes
) Disconnected (Simulator) (@ Buit OK NS (No editor)
IZ] 3 2=
2. WEIFFUAERESR
©» SEGGER Embedded Studio for RISC-V ¥7.32a - Package Manager ? X
Select Packages
GD32VI55x o o 0
Title . Version Type Status Action
GigaDevice
GD32VW55x CPU Support Package 1.00 > | CPU Support Ne Action
A
Package Information
Description This package contains project templates and system files for the GigaDevice GD32VW55x.
Installed Version 1.00
Author SEGGER Microcantroller GmbH o
Back Cancel
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3.2.

B 3-3. &R EEL LR

¥ Install Target Support Packages

1 » ol - Dwes B o Beeelh - GD32VWSSx_Addon
e
-
O == 12 EER ESidl Fob
| © GD32VWS55x - 1.00.emPackage 2023/11/215:01  SEGGER Embed... 443 KB

IZIFEN): | GD32VW5E5x - 1.00.emPackage

v| Support Package Files (~em

ETHERFTETRE

BETREBOF 2 TR RN

IR 1. $TJF SES # A, 7 “File->New Project” ik $ “A C/C++ executable for
GigaDevice GD32VW55x "I & T2 4 FIf Bk Fr i 172, % & 3-4. BEFHEIRIZE T

3-4. ETHERFETRE

> SEGGER Embedded Studio for RISC-V V7.32a - New Project

Select new project template

i) Don't see your device or board? Use the Package Manager to install packages

Description

e

GigaDevice

[AC/C++ executable for GigaDevice GD32vWSSx. |

An assembly code only executable for GigaDevice GD32VW35x,
An externally built executable for GigaDevice GD32VW355x.
Alibrary for GigaDevice GD32VW35x

Name: Project

Location: | DAGD32VW353

GD32VW35x

Manufacturer | Board

GigaDevice
GigaDevice
GigaDevice
GigaDevice

Back

Browse

Cancel

AYR2: i “Next”, HENEM TRERES M, WRFGHER, GikdsdeMikss, Skl s
PRRTUE R, FUE CRWRE, RO BRAEBE, MAML SRR, RKNEE, 254
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GigaDevice
3-5. ETFHRIKAEH TFERE.
&l 3-5. ETHERKEHTERE

©» SEGGER Embedded Studio for RISC-V V7.32a - New Project X

@ Choose common project settings

Properties:

Option Value
Build
= Target Processor GDI2VW553HMOT
Compiler
= Compiler SEGGER
Debugger
* |5A Extensions Debug None
Linker
= Additional Output Format None
Preprocessor

= Preprocessor Definitions
= User Include Directories

Printf/Scanf

= Printf Floating Point Supperted  No

= Printf Integer Support int

= Printf Width/Precision Supported No

» Scanf Classes Supported No

* Scanf Floating Point Supperted  No

* Scanf Integer Support int
Runtime Memory Area

* Stack Size 2,048 bytes

Target Processor

Select a set of target options

Back Cancel

AYR3: middy “Next”, SENTRSCAEFEF M, FAMBOANLEEN, % &3-6. ETHEKA
LR FE

3-6. ETIEMR I TSRS

%» SEGGER Embedded Studio for RISC-V V7.32a - New Project X

@ Select files to add to project

Files:
(2 Device Files
(2 Script Files
[ Source Files
& System Files

Import all files and package files

Back Cancel
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AP 4. fiih “Next”, MENTIERCEILES 1, 5% F3-7. BTEKHK TELE.
B 3-7. ETHERKTELE

%* SEGGER Embedded Studio for RISC-V ¥7.32a - New Praoject

*
@ Select configurations to add to project

Cenfigurations:
Debug
Release

Back

o [ ]

A YR 5:

s “Finish”, HEANTREFE, FIP A AR T B TREHAT — 00T Rk, 2% &
3-8. ETFHERAH LFE-

3-8. ETHEMRIIF L

© Project - SEGGER Embedded Studio for RISC-V V7.32a (64-bit) - Non-Commerdial Li
File Edit View Search  Navigate

Project  Bulld Debug Target Tools Window Help

0 x| =D
OO & O &

Project Explorer

Code | Data+RO

- A

\_ 4

SEGGER Studio

SEGGER Embedded Studio for RISC-V is up to date

Check for Updates
«©

All packages are up to date

Check for Packages

Projects 5 Open existing H [ create new

v
Show: | Transcript T Y N [Tk -

() Disconnected (-Link) € Built OK  INS (No editor)

3.3. BT hr e ER R TR

ST AR R BT TR BRI
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BB 1. $7JF SES M, # “File->New Project” Fililit# “A C/C++ executable for

GigaDevice GD32VW55x” J1-1% & T AL M Bk F i T2, &% &3-9. EFEBEL1EES
BT

& 3-9. ETIRER M EHRTRE

©* SEGGER Embedded Studio for RISC-V V7.32a - New Project

Select new project template ]

i) Don't see your device or board? Use the Packace Manager to install packages

Description

L

GigaDevice

Manufacturer | Board

[AC/C++ executable for GigaDevice GD32VW55x. | GigaDevice
An assembly code only executable for GigaDevice GD32VW35x, GigaDevice
An externally built executable for GigaDevice GD32VW55x.
A library for GigaDevice GD32VW530,

GigaDevice
GigaDevice

Mame: Project

Location: | D:AGD32YWS55x_Firmware_Library\ Template\SES_project Browse

Back Cancel

AYR2: mih “Next”, SENEM TRERES M, WRFEGHERY, GikdIMlkss, S
PERTUEHE, FUE CERE, KOS BRAEBE, WAL SCRRESE, R NEE, 254
3-10. EFArfEE AR TR E
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B 3-10. E TR ERER TERE

©» SEGGER Embedded Studio for RISC-V V7.32a - New Project X

@ Choose common project settings

Properties:

Option Value
Build
= Target Processor GD32VW553HMQT
Compiler
* Compiler SEGGER
Debugger
* |5A Extensions Debug Mone
Linker
= Additional Output Format Mone
Preprocessor

* Preprocessor Definitions
* User Include Directories

Printf/Scanf

= Printf Floating Point Supported Mo

# Printf Integer Support int

= Printf Width/Precision Supported Mo

» Scanf Classes Supported Mo

# Scanf Floating Point Supported Mo

# Scanf Integer Support int
Runtime Memory Area

» Stack Size 2,048 bytes

Target Processor

Select a set of target options

Back Cancel

APR 3. miih “Next”, #EANTRECAFESFES M, POl LA ED, 2% & 3-11.
HFErotE e ) L XA FE

B 3-11. TR 4 ) TR e &

©* SEGGER Embedded Studio for RISC-V V7.32a - New Praoject >

@ Select files to add to project

Files:
o
- [ (0 Seript Files
> [ [ Source Files
> [ [0 System Files

Import all files and package files

Back Cancel

AP 4. miih “Next”, #ANTIEMERFENET, 2% K 3-12. BT FEN TELER
12
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.
& 3-12. BT HrdEEFEN TRERER T

L#3

@ Select configurations to add to project

Configurations:

[ Debug
Release

Back Finish Cancel

A YR 5: gl “Finish”, #EN TS, F7 AT DR T s TREHET — 00T R, %5 &3-13.

TR,
& 3-13. &%

© project - SEGGER Embedded Studio for RISC-V V7.32a (64-bit) - Non-Commercial License

File Edit View Seach Navigste Project Build Debug Target Tools Window Help

Project Explorer

ol
-0e&s o @
Code Data+RO

project’
[ Project ‘project’

SEGGER

=

Studio

SEGGER Embedded Studio for RISC-V is up to date

Check for Updates

All packages are up to date

Check for Packages

Projects

Show: | Transcript v Y % [Tk -

projectemProject saved

= Open existing

i [ Create new

() Disconnected (-Link) @ Built 0K INS (No editer)

AR 6: KGRI SCHHE IR N BT HR, 275 K 3-14. TREXFLEH. BARSIESS

1, SR PERRAR IR -
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& 3-14. TREXH44H

> (0 drivers  14files
o [ env SES Giles

© Project - SEGGER Embedded Studio for RISC-V V7.32a (64-bit) - Non-Commercial License - o X
File Edit  View Search Mavigate Project Build Debug Terget Took  Window  Help
Project Explor [ % | mainc gdizvwss3h_evale  gd32uwssx_gpio.c BEv x
7% Release -oa o o "
Project ltems Code | Data-RO
Solution ‘Project’
4[] Project Project”
4 (X Application 3 files
& gd3azvwsscit.c
& mainc
& systick.c .
4 S Doc Tiile
5 resdmett udilo
4 (X Peripheral 29 files
> [ Source  281iles
& system_gd32vwS5x.c
a ERISCY  20files Check for Updates

SEGGER Embedded Studio for RISC-V is up to date

4 3 ScriptFiles 1 file
L) 6D32vws5x Targetjs
a (3 Utilities 11ile

& gd32vw553h_eval.c All packages are up to date

Projects

Show: | Transcript T Y Y [Tasks v

Check for Packages

I [ Open existing H [ create new v

() Disconnected (GDB Server) @ Built OK  INS (No editor)

JBIR 7. ik “Project->Options”, #F N TREAC & Ftif, Fe & H Pk 85 8%, 5% £ 3-15.

B aE B ERE.
A 3-15. AP BRERE

Project ‘Project ' Options

T L | %rRelease

Code Anslyzer
Code Generation

4 Code Option Value
Assembler
Build 4 B Code Ansiyzer

+ Analyze Command Hene

©| [ Show Modified Gptions Only

< SEGGER Embedded Studio for RISC-V V7.32a - Propenty Editor x

Set User Include Directories

Compil 4 W External Build
Compiler Waring + Assemble Command Hiane
Extesnal Build * € Compile Command Nene Project: Project
File + Co+ Compile Command Niane Configuration: Relesse
Library User Inchusie Directories:
Linker 4 W libeary
Prepeoeessor * Library 1O Hone  modified |
Print/Scanf T
¢ A a“m essor ) tilitin
Runtime Memary Ares Preproc _ § \AFi 325 standard_periphers!
Section | N A Uilities; A\ \\Firrmware\\GD32VWS5x_standard peripheral; \ 12VWSSx_standard,
Source Code e inchude Duectons Assembler Only o | A FirmwereRiscVidrivers -
er Bl Scp = User Include Directories C Compiler On
4 Debug User Include Directories
Debugger
ecifies the user include path. Ths property will have macra expansion spplied to i,
s s p property 2 v
JLink
Loader
Simulator Macros: ~
Target Script
Conce

Specifies the user include path. This property will have macro expansian applied ta it

¥
®

miidi “Project->Options”, #E A LFEACE S, FACEMA XM, 5% & 3-16. BAEA

14
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& 3-16. A E

T L CiRelease

4 Code
Assembler
Build
Code Analyzer
Cade Generation
Compiler
Compiler Warning
External Build
File
Library
Linker
Preprocessor
Printf/Scanf
Runtime Memory Area
Section
Source Code
User Build Step

4 Debug
Debugger
GDB Server
J-Link
Loader
Simulator

Target Script

Options [ Show Madified Options Only

Option Value
4 W Target Script

+ Debug Begin Seript Nene

+ Debug End Script None

+ Load Begin Script None

+ Load End Script None

+ Reset Script Reset(  modified

+_Terget Script File A Firmware\RISCV\env SES\GD32VW55x Targetjs
Target Script File

The target script file, the contents of this file are prepended to script project properties before they are executed,

o]

Cancel |

© SEGGER Embedded Studio for RISC-V V7.32a - Property Editor X

Set Target Script File

Project: Project
Configuration: Release

Target Script File:

Browse

Macros:

Concel

The target script file, the contents of this file are prepended to script project properties
before they are executed,

15
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4.

4.1.

IDE A4

THERC Bk

R ] Dl A b “Project ltems” £ R XN Solution / Project / ScfEske [ e, k4%
“Options...” HATAECEIETNE .

A 4-1. TR EE

-

1 Release ffoaf ©¢F

4 71 Project Project”
4 3 Application 3 iles
i) 932wt it.c

L

23 Periphersl 201ies
(L) Source 28 filles
) ystem_gdsissue

A RISCV 20files
Cddrivers 14 files

(20 env_SES  Efiles
3 Script Files 1 file

15) GD32VWSSs Torgets
3 Utilties 1 file

) gdsBensSah evelc

Fie  Edit View Semch  Novigste Project Buld Debug Target Teal  Window  Help

=HEN -]

vigj€e?

[Project ferns| Code | DatasRO
T SeTuton Project

© SEGGER Embedded Studio for RISC-V V7.32a - Options.

Project 'Project ' Options

=

4+ 1 2 Release
+ Cose
Assarmbier
Bud
Code Analyzes
Code Genarstion
Compiler
Cornpiler Waming
Etarmal Builg
File
Library
Linker
Pregrocessor
Print/Scand
Runime Memory Avea
Section
Source Code
User Build Step
4 Debug
Debugger
GDB Server
Fink
Loader
Simulator
Target Script

Option

o W Assembler
= Assamaler
= Addians| Assembler Options
* Additsanal Assembler Options From File
= Run Pregrocessor

oW B
« Exchude From Build

- Project Type

= Project Directary

- Output Directory

« Intemediate Drectary
= Esecutabie Fie bame
= ObjectFile Name

= Project Macros

] Show Medified Opticns Only:

Vahue. -

e

Mane
es

He

Executeble  inharits

stion/xe
ationl/Oby/S{Projecthlame]
cjecthlamelS(EXE)
inputamel$(0BI)

o] [ canee

3 Disconnected (GD8 Server) @ Built OK N5 (o editar)

|>i.‘" x

o

& ox

16
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4.1.1. oyt

& 4-2. &R

%* SEGGER Embedded Studio for RISC-V V7.32a - Options x

Project 'Project ' Options

T 4 | 5% Release - [] show Medified Optiens Only

4 Code Option Value
Assembler
Build 4 B Buid
Code Analyzer » Target Processor GD32VW553HMQT (inherits)
Code Generation
Compiler 2 B Bdternal Build
Compiler Warning » Assemble Command None
External Build » C Compile Command None
File » C++ Compile Command None
Library
Linker
Preprocessor
Printf/Scanf
Runtime Memory Area
Section
Source Code
User Build Step

4 Debug Target Processor A
Debugger Select a set of target options
GDE Server
J-Link ® property rv_architecture=rv32gc
Loader * property rv_shi=ilp32d
Simulator ® property target_device_name=GD32VW533HMQT

* property debug_register_definition_file=$(PackagesDir)/GD32V W55/ XML/GD32VW553x_Registers.xml
Target Seript * property linker_memory_map_file=S(PackagesDir)/GD32VWS55x/ XML/ GDIZVW533HMOT_MemaryMap.xml

® nranarte

Cancel

17
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4.1.2.

TG4 19 4% B B

& 4-3. LA E

©» SEGGER Embedded Studio for RISC-V V7.32a - Options X

Project 'Project ' Options

1+ L [£ERelease ~ | |assembler | @ [ Show Modified Options Only

4 Code Optien Value
Assembler
Build « B Assembler
Code Analyzer » Azsembler cC i
Code Generation » Additicnal Assembler Options g
Compiler = Additional Assembler Options From File SEGGER
Compiler Warning SEGGER Assemnbler
External Build
File
Library
Linker
Preprocessor
Printf/Scanf
Runtime Memory Area
Section
Source Code
User Build Step

a4 Debug Assembler
Debugger
GDB Server
J-Link
Loader

Specifies which assembler to use, SEGGER Assembler Technology preview - For test purposes only.

Simulator
Target Script

Cancel

& 4-4. nikasACE

%* SEGGER Embedded Studio for RISC-V V7.32a - Options *

Project ‘Project ' Options

1 L [F2Release ~ || compiler | ©| [ Show Modified Options Only
4 Code Optien |Va|ue ‘ A
Assembler
Build a W Compiler
Code Analyzer = Compiler SEGGER | inherits E
Code Generation * Use Compiler Driver gcc
Compiler » Keep Assembly Source
Compiler Warning * Keep Preprocessor Output T
External Build * Supply Absolute File Path Yes
File = Enable All Warnings C Compiler Only Command Line Options
Lib = Enable All Warnings C++ Compiler Only Command Line Options
! ren = Enable All Warnings Command Line Options
Linker = Enforce ANSI Checking C Command Line Options
Preprocessor » Enforce ANSI Checking C++ Command Line Options
Printf/Scanf = Enforce ANSI Checking Command Line Options
Runtime Memory Area = Additional C/C++ Compiler Options
Section = Additional C/C++ Compiler Options From File None
Source Code = Additional C Compiler Only Options .
. » Additinnal C Comniler Onlv Ontions From File None
User Build Step
a4 Debug Compiler
Debugger Specifies which compiler to use.
GDB Server
J-Link Inherits
L.oader "SEGGER" from project in Commen configuration
Simulator
Target Script

18
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4.1.3.

4.1.4.

FEENA KRR IR AR E

& 4-5. FEMA K HgEcE

1T | £ Release - Options [ Show Medified Opticns Only
4 Code Option Value (o)
Accembler
Build 4 W Linker
Code Analyzer o Linker SEGGER _inherits
Code Generation [» _Linker Script File S(PackagesDir)/GD32VW55x/Scripts/GD32VW55x_Flash.icf |nd
Compiler * Memory Map File $(PackagesDir)/GD32VW55:/ XML/GD32VW553HMOT_Memoryl
Compiler Waming * Memory Map Macros
External Build * Memory Segments Mene
File * Supply Memory Segments To Linker [segger-Id] Yes
L » Generate Log File [segger-Id] Mo
» Generate Map File [segger-ld] Standard

Map File Format [seqger-ld] Text
Preprocessar Additional Qutput Format None = I
Printf/Scanf Link Dependent Projects Yes
Runtime Memory Area * Additional Input Files
Section » Linker Symbol Definitions
Source Code * Entry Point Reset Handler inherits

User Build Step + Keen Svmhnls

4 Debug Additional Qutput Format
Debugger The format used when creating an additional linked output file.The options are:
GDB Server
J-Link  None do not create an additional output file.
Loader * bin create a binary file.
Simulator * srec create a Motorola S-Record file.
* hex create an Intel Hexfile,
Target Script

M R E

& 4-6. 1/0 FERLE

%* SEGGER Embedded Studio for RISC-V V7.32a - Options X

Project 'Project ' Options

T L | £3Release -

4 Code Option Value
Assembler
Build 4 M Llibrary
Code Analyzer ¢ Library IO None ' modified =]
Code Generation RTT
Compiler SEMIHOST
Compiler Warning SEMIHOST (host-formatted)
External Build MNone
File
Library
Linker
Preprocessor
Printf/5canf
Runtime Memory Area
Section

@[] Show Medified Options Only

Source Code
User Build Step

4 Debug Library 1/0 2
Debugger Specifies how the library daes 1/0.
GDE Server Options are:
J-Link
Loader ® RTT: Use SEGGER Real-Time Transfer for I/0 eperations without halting the system, Recommended for maximum speed.
Simulator * SEMIHOST: Format output and write to RAM buffer. Halt CPU for [/0 operation. Provides hosted file [/0.
* SEMIHOST (host-formatted): Halt CPU for /0 operation. Recommended for minimum size.
Target Script * None: Do not include |70 implementation, Use user-supplied 1/0 Mechanism,

Cance

1% 4 None I, Fil 2 ali@id f&i% “SEGGER_RTL_PRINOPS_UART Unbuffered.c” SCfF
19
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4.1.5.

%2 USART_PRINT 8 E4TEDER O, &% B A4-7. FHEOFE.
A 4-7. AR ORE

*

*/

SEGGER_RTL_PRINOPS_UART Unbuffered.c

#include "_ SEGGER_RTL_Int.h"
#include "gd32ww5s5x.h"
#include "stdio.h™

24 |pdefine USART PRINT |USaRTe

B b T e ]

B AR RSO IR

&l 4-8. A A A SR E

%> SEGGER Embedded Studio for RISC-V V7.32a - Options

Project 'Project ' Options

T | | 53 Release

4 Code
Assembler
Build
Code Analyzer
Code Generation
Compiler
Compiler Warning
External Build
File
Library
Linker
Preprocessor
Runtime Memory Area
Section
Source Code
User Build Step
4 Debug
Debugger
GDB Server
J-Link
Loader
Simulator
Target Script

Search Options

Option

4 MW Printf/Scanf

Value

[ Show Modified Options Only

Printf Floating Point Supported
Printf Integer Support

Scanf Classes Supported

Scanf Floating Point Supported
Scanf Integer Suppert

Wide Characters Supported

Printf Width/Precision Supported

Float modified
int
Yes modified
No
No
int
Yes modified

Printf Floating Point Supported

Are floating point numbers supported by the printf function group.

Cancel
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4.1.6.

4.1.7.

At E R E

& 4-9. HULEAE

% SEGGER Embedded Studio for RISC-V V7.32a - Options

Project 'Project ' Options

T 4

4 Code
Assembler
Build
Code Analyzer
Code Generation

1.5 Release

Compiler
Compiler Wamning
External Build

File

Library

Linker

Printf/Scanf
Runtime Memory Area
Section
Source Code
User Build Step
4 Debug
Debugger
GDB Server
J-Link
Loader
Simulator
Target Script

earch Options

Option
@ TTEpPTOEsSOr
* Ignore Includes
¢ Include Files
¢ Include Files Assembler Only
#* Include Files C Compiler Only
¢ _Include Files C++ Compiler Only

[] Show Modified Options Only

Value &

¢ _Preprocessor Definitions

inherits |

¢ Preprocessor Definitions Assembler Only

¢ Preprocessor Definitions C Compiler Only

* Preprocessor Definitions C++ Compiler Only

* Preprocessor Undefinitions

* Preprocessor Undefinitions Assembler Only

* Preprocessor Undefinitions C Compiler Only

* Preprocessor Undefinitions C++ Compiler Gnly
* System Include Directories

¢ _Undefine All Preprocessor Definitions

No

|+ User Include Directeries

e ULl es;. G AN Firmware\ GD32VW55x_standard_p- | W

User Include Directories

Specifies the user include path. This property will have macro expansion applied to it.

Cancel
MACERIE
4-10. RHEREE
% SEGGER Embedded Studio for RISC-V V7.32a - Options X

Project 'Project ' Options

o

4 Code

£,1 Release

Assembler

Build

Code Analyzer

Code Generation

Compiler

Compiler Waming

External Build

File

Library

Linker

Preprocessor

Printf/Scanf

Runtime Memory Area

Section

Source Code

User Build Step
a4 Debug

Debugger

GDB Server

J-Link

Loader

Simulator

Target Script

Option

4 B Code Generation

+ Disable Function Inlining
Keep Link Time Optimization Intermediate Files
Link Time Optimization
Link Time Optimization Additional Options
Machine Qutliner [segger-cc]
QOptimization Level

4 W Library
« Library Optimization

4 W Linker
= Enable Outline Optimization [segger-Id]
Optimization Level
Specifies the optimization level to use. The options are:

* Nene - don't specify an optimization level

*® Level 0 - no optimization, fastest compilation and best debug experience.

® Level 1- optimize minimally.
® Level 2 for speed

*® Level 2 balanced

*® Level 2 for size

® Level 3 for more speed - optimize even more, will take longer to compile and may produce much larger code.

©/ [ Show Modified Options Only

Value

Mo
Ne
Mo

Mone.

Mone  modified i

Level 0
Level 1

Level 2 for speed
Level 2 balanced

Level 2 for size

Level 3 for more speed

Cancel
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4.1.8.

4.1.9.

REE

A 4-11. REE

%» SEGGER Embedded Studio for RISC-V V7.32a - Options

Project 'Project ' Options

T L | 9% Release -
a Code

Assembler

Build

Code Analyzer

Code Generation

Compiler

Compiler Waming

External Build

File

Library

Linker

Preprocessor

Printf/Scanf

Runtime Memory Area

Section

Source Code

User Build Step
4 Debug

Debugger

GDB Server

J-Link

Loader

Simulator

Target Script

Option

4 H Code Generation
» Stack Sizes

4+ H Debugger
* Starting Stack Pointer Value

4 H Linker
» Suppress Warning on Executable Stack

4+ H Runtime Memory Area
* Stack Size

@ [ Show Modified Options Only

Value

_stack_end__ inherits

No

WRAREE

AP AT BLiE#E J-Link 2¢ GDB Server 77 aEAT TR FEAMM K #E, =% & 4-12.

2o
4-12. FARBEE

%> SEGGER Embedded Studio for RISC-V V7.32a - Options

Project 'Project ' Options

Code Analyzer
Cede Generation
Compiler
Compiler Warning
External Build
File
Library
Linker
Preprocessor
Printf/Scanf
Runtime Memory Area
Section
Source Code
User Build Step

4 Debug
GDB Server
J-Link
Loader
Simulator
Target Script

T L |2 Release = | [Search Options

4 Code Option
Assembler
Build 4 W Debugger

Target Connection

Run To Control

Run To

Startup Completion Point
Start From Entry Point Symbol
Leave Target Running
CPU Register File
Register Definition File
Debug Terminal Log File
Threads Script File
Thread Maximum
Working Directory
Command Arauments

Target Connection

Specifies the target to connect to for debugging actions,

[ Show Meodified Options Only

Value ®

[ J-Link_ modified -]
Simulator
GDB Server
Ye& TRt
No
$(StudioDir)/targets/cpu_registers_riscv.xml
$(PackagesDir)/GD32VW35x/XML/GD32VW5353x_Registers.xml
None

None

25

$(ProjectDir)

$(ProiectNamel S(EXE) v
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ik FE J-Link kAT TR AE, 5% &4-13. J-Link L&

& 4-13. J-Link . B

©* SEGGER Embedded Studio for RISC-V V7.32a - Options

Project 'Project ' Options

T L |3 Release [] Show Modified Optians Gnly
4 Code Option Value “

Assembler

Build 4 W Jlink

Code Analyzer *_Host Connection U]

Code Generation |_Tarqet Interface Type JTAG (inherits) |

Compiler » JTAG Instruction Register Size Before Target Auto Detect

Compiler Warning » JTAG Number Of Devices Before Target Auto Detect

External Build + Enzble Adaptive Clocking No

» Speed 4,000 kHz
File
lib * Supply Power No
! rany » Show Log Messages In Output Window Yes

Linker « LogFile None

Preprocessor s Script File None

Printf/Scanf * Exclude Flash Cache Range None

Runtime Memory Area s Additional J-Link Options

Section o Taraet Has Cucle Counter Mo w

Source Code Target Interface Type

User Build Step
4 Debug Specifies the type of interface the target has, The options are:

Debugger *JTAG - Use JTAG interface

GDB Server * SWD - Use SWD interface

J-Link * cJTAG - Use JJTAG interface

Loader Inherits

Simulater

Target Script "JTAG" from project in Commeon configuration

Cancel

MikHF GDB Sever FUiHAT TR KK, HEBEFHERIEFEEH
GDB Server I &.

4-14. GDB Server L&

GDB Server, &% & 4-14.

% SEGGER Embedded Studio for RISC-V V7.32a - Options

Project ‘Project ' Options

T L | %fRelesse Options [] Show Modified Options Only
4 Code Option Value @
Assembler
Build 4 B GDBServer
Code Analyzer = Host localhost
Code Generation = Type nk (mo =
Compiler
Compiler Warning * Auto Start GDE Server Yes  modified
External Build * Port 2,331  modified
File » Reset and Stop Command modified
Lib » Ignore Checksum Errors modified
! rary * Allow Memory Access During Execution modified
Linker = Register Access modified
Preprocessor » Breakpoint Types Hardware and Software
Printf/5canf = LogFile Nene
Runtime Memory Area = Target XML File None
Section » Connect Timeout 5 seconds b
Source Code Type
User Build Step
4 Debug Specifies the type of GDB server being connected tU.IJ-Lmk, OpenOCD, 5T-LINK and pyQCD gdb serverllmplementatmns are currenthy
supported,
Debu
J-Link
Loader
Simulator
Target Script
o
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4.2. TR YR PRIE I

W SRR “Build” S350, FIXF Project / Solution HEATIERR, 4 AN E g EARAE: JFA]
xF A HE R TAEPAT 9 5 1817 BOR B, 275 B A-15. T4 EAR.

& 4-15. TR FIRM

* Project - SEGGER Embedded Studio for RISC-V V7.32a (64-bit) - Non-Commercial License
File  Edit View  Search  Mavigate  Project Debug  Target Tools  Window  Help

on
Project Explorer %f Build Project F7

Rebuild Project Alt+F7

iof Release =2 @& Aid Clean Project
Project ltems Q. T S Shift+E7
Solution ‘Project’ g Burdolution e
4 [7] Project ‘Project ’ Rebuild Solution Alt+Shift+F7

- [ Application 3 files Clean Solution

- [[J Doc  1file .

g -
- [0 Peripheral 29 files % Compile Ctri+F7
> [ RSCY G b Build and Debug Chrl+T, F5

+ [ Script Files 1file
. [ Utilities 1 file 14 Build and Run Ctrl+T, Ctrl+F5
- §2 Output Files

g Cancel Build Ctrl+.

€22 Build Configurations...
Set Active Build Configuration 1
Batch Build 3
Parallel and Unity Build 3
Show Build Log Ctrl+B, Ctrl+T

4.3. TR

A T AL “Debug” BRI, WG E AR HEAT S, W st B AR, %5 4 4-16.
LR TN [ A-17. L2 IR ] -

4-16. TR ER
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File

Edit View Search

Mavigate

* Project - SEGGER Embedded Studio for RISC-V V7.32a (64-bit) - Non-Commercial License

Build | Debug | Target  Tools

Project Explorer

=
1.4 Release

Project ltems

ToOOg o«

| Code | +—

Solution 'Project’
a4 [7] Project ‘Project

Go
Break
Stop
Restart

Toggle Breakpeint

Window  Help

F3

Ctrl+.
Shift+F5
Ctrl+5Shift+F5

Fa

i [ Application 3 files Breakpoints »
(£ Doc  1file
: : o
i~ [0 Peripheral 29 files Z Steplnto F11
[ RISCY 20 files I:_E Step Owver F10
I+ [0 Script Files 1 file GE Step Out Shift+F11
> Utilities 1 file —
Q ) +=  Run To Cursor Ctrl+F10
I g2 Output Files B
5= Auto Step
Instruction Step Into Alt+F11
= Show Mext Statement Alt+*
I=  Set Mext Statement Shift+F10
Switch Debug Mode Ctrl+F11
Quick Watch Shift+F9
Debug With Ozone Alt+F3
Options 3
N
Bl 4-17. TRERAE
© Project - SEGGER Embedded Studio for RISC-V V7,328 (64-bit) - Non-Commercial License (Stopped) - a x
i G (V] Senh Meigme Browct B4 Owvs Tage Tock  Wdow e
Proee vl ] auap B stop  stepinto step out B x| @D BeB g %
O Outpat '] ~
1 Release - hoject_Release = | @ int main - T[T a m FE - % O mD e
jecthins | 1 Pojcttpore o 1_evad_ted oniL203); . | orusen .
4 Dl Proie o poemants Chrte ek eval_led of(LED3);
‘ J'h'- Clipboard Ring Core dite }
LE CodeOuine Crieaiels Limingielaylocal-;
b My References Core AR e ,‘f,,f,,‘m,mm -
A0 Source Navigator Chrle Ait+H
j;‘:: T ChivaleY
(3 5¢c & Stack Usage Mo lo<als
Qi [in] s
W10/ &) Disassembly cweF12 [out] none
Sp= {iaioon
A Globaks CuleAlteG int main(void)
G leck Crtealted TP ntigure systic +7
8 Dengleminl  CuieteD st sonttgs
& calsac Cuears
[ +Link Control Panel
i , = o x
[ » woous |@ - 4+ 4 W% F@
P . |
Mo Dibug Windows . | Mome [ voe Asdess |
A vz UE
Teabar B
Status Bar » printf( = CPU.RV321 LI
O fulsoeen s | 2L [ure
T =05 SF(RESET == gd_eval_key_state_get(KEY_TANBER_WAKELS)) { ll: a
L Frre s ¥ Q=
) B 4+ |F:u
i
5. B
= = o ol 82
consies | 512,
e |l
I ——— -
e

8 Flink ) Buitt 0K
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4.4, B it i AR

I AR AL “Target” 3T, AIATHARS A PATER:, WiTF, WE, RIS,
% [ 4-18. HErE N RIE.
& 4-18. Hirih h#fE

% Project - SEGGER Embedded Studio for RISC-V V7.32a (64-bit) - Non-Commercial License

File  Edit  View  Search  Mavigate  Project  Build  Debug Tools  Window  Help

ProerEpioneT % Connect J-Link Ctrl+T, C
- % Disconnect Ctrl+T, D
o - o o
%ol Release o @ o < 2 | % Reconnect Ctrl+T, E
Project ltems Code iE Attach Debugger Ctrl+T, H
Solution ‘Project’
a4 [7] Project Project’ 12.5k|| ™ Reset Ctrl+T, S
- [0 Application 3 files 1= Download GD32VW35x Ctrl+T, L
+ [ Doc 1file Z  Verify GDI2VWS5x Ctrl+T, V
- ([ Peripheral 29 files
. [CA RISCY 20 files Eraze All Ctrl+T, K

+ ([0 Script Files 1 file

- [C Utilities 1 file

+ k2 Output Files Download File »
Werify File 3

Upload Range...

_ycle Counter
e Counter

.3 Zero Cycle Counter Ctrl+T, Z

Switch Project 3

Target Connection Properties
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Important Notice

This document is the property of GigaDevice Semiconductor Inc. and its subsidiaries (the "Company"). This document, including any
product of the Company described in this document (the “Product”), is owned by the Company under the intellectual property laws and
treaties of the People’s Republic of China and other jurisdictions worldwide. The Company reserves all rights under such laws and
treaties and does not grant any license under its patents, copyrights, trademarks, or other intellectual property rights. The names and

brands of third party referred thereto (if any) are the property of their respective owner and referred to for identification purposes only.

The Company makes no warranty of any kind, express or implied, with regard to this document or any Product, including, but not
limited to, the implied warranties of merchantability and fitness for a particular purpose. The Company does not assume any liability
arising out of the application or use of any Product described in this document. Any information provided in this document is provided
only for reference purposes. It is the responsibility of the user of this document to properly design, program, and test the functionality
and safety of any application made of this information and any resulting product. Except for customized products which has been
expressly identified in the applicable agreement, the Products are designed, developed, and/or manufactured for ordinary business,
industrial, personal, and/or household applications only. The Products are not designed, intended, or authorized for use as components
in systems designed or intended for the operation of weapons, weapons systems, nuclear installations, atomic energy control
instruments, combustion control instruments, airplane or spaceship instruments, transportation instruments, traffic signal instruments,
life-support devices or systems, other medical devices or systems (including resuscitation equipment and surgical implants), pollution
control or hazardous substances management, or other uses where the failure of the device or Product could cause personal injury,
death, property or environmental damage ("Unintended Uses"). Customers shall take any and all actions to ensure using and selling
the Products in accordance with the applicable laws and regulations. The Company is not liable, in whole or in part, and customers
shall and hereby do release the Company as well as it’s suppliers and/or distributors from any claim, damage, or other liability arising
from or related to all Unintended Uses of the Products. Customers shall indemnify and hold the Company as well as it's suppliers
and/or distributors harmless from and against all claims, costs, damages, and other liabilities, including claims for personal injury or

death, arising from or related to any Unintended Uses of the Products.

Information in this document is provided solely in connection with the Products. The Company reserves the right to make changes,

corrections, modifications or improvements to this document and Products and services described herein at any time, without notice.

© 2024 GigaDevice — All rights reserved
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